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What is LinkedIn?

LinkedIn (http://www.linkedin.com) is an online networking site that is
widely used by professionals, companies and associations in the
financial industry. It is free, interactive, available 24/7 and even offers
an option for some settings in different languages.

Our main reason for recruiting ISSA’s membership to LinkedIn is to use
its infrastructure to support a new ISSA group for lively exchanges of
news and discussions among ISSA member companies and their
interested staff.

In order to login to LinkedIn and join the ISSA group, you'll first need to
sign up to join LinkedIn. It's free to sign up to create a LinkedIn account.

Here's how to sign up for and login to LinkedIn.
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Signing Up

Information Needed to Sign Up for LinkedIn

First Name

Last Name

Email Address (this email address will be used to log on each time)
Password (choose your own password)

TB]B]HLII‘IRE(IB, sign up' belnw ___:‘l‘-l's ﬂ'eel LinkedIn helps you...

+ Establish your professional profile online

Email: |

First Name: | | # Stay in touch with colleagues and friends
Last Name: | | + Find experts, ideas and opportunities

New Password: |

§ or more characters

Join Linkedin !

Already on Linkedin? Sign in

* By clicking Join Linkedln, you are indicating that vou have read, underztood, and agree to Linkedin's User Agreement and Privacy Policy
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Log on page

Information Needed to Sign Up for Linkedin
* First Name
« Last Name
« Email Address (this email address will be used to log on each time)
« Password (choose your own password)

Linked ﬁm

Home  What is Linkedin?  Join Today  Sign In

Sign in to Linkedin

Email address:

Password:

m ar Join Linkedin

Forgot pagsword?

L User Agreement | Privacy Pelicy | Copyright Pelicy
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Create a LinkedIn Profile

After you have signed up for a Linkedln account, you'll be able to create
your LinkedIn profile especially at your current position. This is very
important as we need to quickly identify who you are so we can approve
you for membership. You can upload a digital photo to your LinkedIn
profile. A headshot is recommended.

The Professional Summary section of your profile is a good way to
highlight your experience.
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Selecting Language Setting

You can select your language in which you view LinkedIn from the Settings
page or by clicking the Language link at the bottom of any page. Current
languages available are Deutsch, English, Espanol, Francais, Italiano,
Portugués, Romana, pycckuin, and Turkce.

All LinkedIn-generated content (e.g. page titles, menus, etc.) will display in the
language you choose. User-generated content (e.g. group discussions,
recommendations, etc.) will display in the language in which it was written.

Once you choose a language, the site will remember your selection for
subsequent visits.

When you send a message on LinkedIn that includes customized content, it will
be sent exactly as written. When standardized messages are sent out,
LinkedIn’s translation software will attempt to match the language setting
chosen by the recipient. If you need additional translation services please visit
an online translation service such as Google Translate at
http://translate.google.com
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LinkedIn Login

Once you have created a profile, you'll be able to login to your LinkedIn
account at any time to update your profile, connect with networking
contacts, send messages to those contacts, even find information on
jobs, hiring companies, and join career and business-related groups,
including our new ISSA group.

The ISSA group can be found directly by copying this link into your

browser window:
http://www.linkedin.com/qroups?qid=4083174&trk=hb side g

LinkedIn offers the option to get an email when there is a new posting in
the ISSA group.
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Finding the ISSA group on LinkedIn

In the right hand section of the menu bar you will see a search box.
Select “Groups” from the dropdown button and type in “ISSA,
International Securities Services Association” and then click on the blue
magnifying glass or press your ‘enter’ key.

Linked [{i] Type: Bask : _
@ Account Type: Basic * Wiliam P. Corrigan ~ Add s
Home Profile Contacts Groups Jobs Inbox  Companies  MNews More Groups -  International Securities Senices Association

Profile: English ~
T ~ .
9 William P. Corrigan
Yeteran Marketing Pro, Training Consultant & Coach Edit profile
Greater Mew York City Area | Professional Training & Coaching
Ask for recommendations

Create your profile in another language

William P. Corrigan The IS5A now has a group on Linkedinl This is great
news far the industry!

ISSA. the International Securities Services Association
ISSA linkedin.com
g Global, cross-industry and non-partisan, I55A aids in setting
industry direction with fact-based guidance on key
glabalfregional strategic matters of impartance to custodians,
depositories, CCPs and other asset processors; provides
recommendations..

Like « Comment « Share « See al activity
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Joining the ISSA group

When you press enter you will see the ISSA group

[Note: please be as specific as possible when searching for the group
as there are over 120 different groups with the same acronym, ISSA!
Make sure you look for our familiar ISSA logo below.]

LinkEd‘J ACOBUNT Type: BBs = Wiliam P Corngan  Add Connections

Home Profle Contacts Growps  Jobs  Inbox  Companies News  Wome Groyps = inlgmational Secumied SenioRs assocabon E

Search Results {1)

Saarch Groups
imternational sacurities senice ISS.ﬂ- the Int&rnnlnnal Suurltlas sar'-lt.as Asgnl:li!h:-ﬂ
lSSA s MiSEion is |6 pro |'|-ﬂ hip i the lar 1l [ I it af best pr
Al CElepInes Bt —_— '.l IT:l e EMaency and risk 1a 3':IE 'IE n the ]|:It- 3'5- l'S-E ng Industry
Owerer, Mary A shan | 2 members | Share
Chooae b

Paps 1

Create a Group

Linkedin Groups can halp you
Stay infomned and keep in
tauch with people that share
your interests, Create & group
Lo ay

Create 4 Gi oip
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Joining the ISSA group

Click on the “Join Group” button on the right hand side of the group
name and description.

Membership is open to all staff at ISSA member organizations and the
ISSA group is a “members’ only” group. You will receive naotification
that your request for membership was received.

.
L|r|kedﬁa Account Type: Basic « Wiliam P. Corrigan

Home Profle Contacts Groups Jobs Inbox Companies MNews More Groups ~ m

ISSA ISSA. the International Securities Services Association
- Discussions | Search Ware Share group

“Your membership iz pending approval. You can adjust your settings here »

s
. Meil Henderson has joined the
group
hour ago - Send message
Maximum length is 200 characters. 1hour aga - Send message
P 0 S Mary Ann Callahan has created
# Attach a link i Share cap )
Your Activity the group Im_,h_ the I‘ntane_ltlgnal
Securi ities Senices Associa tion
3 hours ago - Like Comment

See all updates »

What's Happening -  EE0
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Joining the ISSA group

Once you are approved you will receive a notification via email that your

membership was reviewed and approved and you will have full access
to the group.

Bill Corrigan To |william Corrigan/DTCCEOTC
0911212011 02:51 Ph cc
bec
Subject Welcome to [554. the International Securities Services Association on Linkedin

History: 4 Thig meszage has been replied to.

From: "[53 A the International Jecunties Sernices Aszociation” <groups-noreply@inkedin com=
Date: September 12, 2011 2:37.02 FM EDT
To: "Williat P Corrigan”

Subject: Welcome to ISSA. the International Secwrities Services Association on LinkedIn

ISSA. the International Securities Services Association welcomes you

o will now receive all benefits of membership including:

® Daily orweekly email digests
» Lpdates about the latest activity in the group
* Jaining like-minded professionals

Yisit This Change Your Learn
Group Setlings flore
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Joining the conversation

As a member of the ISSA LinkedIn group, we encourage you to share
any articles, documents or other materials that you feel would benefit
the group and further its mission.

Iaximum length iz 200 characters

Add a Link

our ACIviy

Whats Happening -~  [EW
Zhow all RSE discussions -
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Joining the conversation

To do this, simply visit the ISSA group site and either make a comment on
someone else’s discussion or start a new discussion. Remember, your
headline comments are limited to 200 characters at a time, but as soon as you
fill in the top box, another box opens, inviting you to “Add more details” (up to
4000 characters). Then you can add a URL link for articles and reports. As
long as you post these as a link, there is no copyright issue.

Then click the “Share” button in the lower right-hand corner. Linkedin allows 15
minutes to make any edits, and after that, everyone in the group will be able to
see your comment.

-
tiit

Add a Link

What's Happening - EE0
Show all RS2 discussicns -
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Commenting

You will also have the opportunity to comment on any articles,
discussions or comments made within the group. To do so just click the
“Comment” button under the post that you want to comment about, type
your comment in the text box and that click “Add Comment”.

what information you would like to see or items you'd like to discuss

this week.
You have 14 minutes Edit

# Hello, and welcome to the ISSA LinkedIn group site. Please let us know

® Like 7 Comment 37 Unfallow {E%\Flag More =

Be the first to comment!

# Send me an email for each new comment ] A ~dd Comment
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How to cut and paste an URL to share an article or report

1. Find the correct URL. When copying from a blog it can be easy to get the URLs
confused. The URL for the main site will look like http://www.thesite.com. Each blog
post also has a specific URL. The webmaster may have formatted the URLs to
include the post title, date or number. To find the specific blog post URL, click on the
title. You should just see one post instead of all of the posts that were on the
homepage.

2. Highlight the URL. Click at the beginning of the address bar to highlight the URL. You
can also highlight any URL by placing your cursor at the beginning of the text. Click
the left mouse button as you drag the mouse over the text. With a little practice this
will become an easy and handy maneuver. In most browsers, you can also click on
the address in the address bar to select it.

3. Use the "Edit" menu. This is on the top of your web browser next to the "File" menu.
Scroll down to the "Copy" option and click on it. Then move to the notepad or window
where you'd like to paste the URL. Go back to the "Edit" menu and select "Paste."
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How to cut and paste an URL (continued)

4. You can also copy and paste with keyboard shortcuts. Shortcuts allow you to easily
copy and paste the URL with little to no mouse movement. Highlight the URL as
before. The keyboard shortcut for copy is "Ctrl+C." Hold the "Ctrl" key down, then
press the "C" key briefly, then let go of the "Ctrl" key. To paste use "Ctrl+V."

5. Copy and paste a URL with a simple mouse click. When you see a URL you want to
copy, right-click on it. A pop up window will appear. Click on the "Copy Link Location"
option. Paste using a keyboard shortcut or the "Edit" menu. You can also paste by
right-clicking on the mouse, and selecting "paste”.

6. Paste the URL. You can paste the URL as text. For easier use, paste it so that other
users can click on the URL on your blog, web page or email. This is called a hyperlink.
Select and copy the URL as usual. Go to your blog post or email. Highlight the word
that you want to contain the link. Find and click on the link icon in your software. This
usually looks like a chain link. Use keyboard shortcuts to paste your link.
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Putting it all together

o i |§, http: e, linkedin, cornjgroups? abouk=_ggid=40831 74&trk=anet_ug_grppro v| 4yl [ % |

-

Edit View Fawvorites Tools Help

'1":;? [g. 1554, the International Securities Services Associatio... l l ?;:} v D m
Linked 3 -
(=] @ Account Type: Basic * Mary Ann Callahan Add Connections
Horme  Profile Contacts Groups Jobs  Inbox 41 | Cornpanies  Mews  More Groups ~ |Search... a

ISSA ISSA. the International Securities Services Association

T ) )
Discussions  Members  Search  More.. Share group

Global, cross-industry and non-partisan, 1354 aids in setting industry direction with fact-based

guidance on key global/regional strategic matters of importance to custodians, depositories,

ZCPs and ather asset processors; provides recommendations for globalfregional ar cross Created: September 12, 2011
industry issues related to custody, depositories, CCPs and securitiesfasset sericing, and
provides & forum for senior level discussion of globalfregional strategic matters and developing
personal global contacts. Members: 5

Type: Professional Group

Owner: Neil Henderson

Managers: Leola Grayson
Group Members in Your Network

Wehbsite: http:/Awiew. issanet. arg
Leola Grayson
Senior Executive Assistant at DTCC

Neil Henderson
¥ Managing Directar at DTCC
:

William P. Corrigan
““8 ‘eteran Marketing Pra, Training Consultant & Coach

‘

Peter Gnepf
Directar, Wealth Management & Swiss Bank, Securnties Services bei UBS AG

Help Center | About | Blog | Careers | Adverdising | Recruiting Solutions | Tools | Mohile | Developers | Publishers | Language | Upgrade Your Account
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Putting it all together

Most Popular Discussions

bl
.y

el
Unfallow

Peter
Unfallow

Welcome to ISSA's Linedln site,aiming to become an active forum for
discussions and info sharing. To start off, see link to MGI's Mapping...
One interesting point is that cross-border investments previously centered on the US and
Europe. The size and complexity of linkages ...

McKinsey & Company - Mapping global capital markets

2011 mckinsey.com
Report Mapping global capital markets. .
posted 20 hours ago

See more »

MNeil, | think it's great for ISSA’s Operating Committee to create a forum
to exchange discussions and news. Page 32-33 of McKinsey...

Here's the full text of the McKinsey Global Institute report.
hitp:fiwww.mckinsey.comimgifreportsifreepass_pdfsiMapping_global_

capital_marketsiCapital_markets_update_email.pdf
pozted 4 hours ago

SEe mare

McKinsey on p 8 also notes that global capital inflows to Latin America
in 2010 exceeded ALL flows to China, India and Russia COMBINED.
Don't migs: SIBOS' LatAm stream stats 2 p.m. Tues, Sept 20 in Community Rm 4

The McKinsey Report also highlights that global ...

acsda.org acsda.org
posted 27 minutes ago

See mare »

27 minutes ago « Like  « Acdd

Peter Gnepf started a dis
Meil, | think it's great for |2
Cperating Committee to ©
forurn to exchange discus
news. Fage 32-33 of Mck
report compares cross-bo
now vs 1993,

4 hours ago - Like - Add col

Peter Gnepf has joined t|

4 hours ago « Send message

S
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Bringing value to the industry

Please note that group has been created to support our shared mission.
With this LinkedIn group we’ve eliminated some barriers such as
language, distance and time. You can share and add to the discussion
regardless of your native language or which time zone you are in.

We look forward to your feedback and input as we strive for a value-
added continuous improvement.

The more content you add the more valuable this resource will become,
so please feel free to share whenever and wherever you may be!
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